### Introduction to Computer Hardware

**Desktop PC**: A computer that is flat and usually sits on a desk. The original design for a home computer.

**Tower PC**: A computer that is upright—it looks like someone took a desktop PC and turned it on its side. In catalogs, the word desktop is sometimes used as a name for both the flat design style pictured above and the tower design.

**Monitor**: The monitor is a specialized, high-resolution screen, similar to a high-quality television. The screen is made up of red, green and blue dots. Many times per second, your video card sends signals out to your monitor. The information your video card sends controls which dots are lit up and how bright they are, which determines the picture you see.

**Keyboard**: The keyboard is the main input device for most computers. There are many sets of keys on a typical “windows” keyboard. On the left side of the keyboard are regular alphanumeric and punctuation keys similar to those on a typewriter. These are used to input textual information to the PC. A numeric keypad on the right is similar to that of an adding machine or calculator. Keys that are used for cursor control and navigation are located in the middle. Keys that are used for special functions are located along the top of the keyboard and along the bottom section of the alphanumeric keys.
### Mouse
An input device that allows the user to “point and click” or “drag and drop”. Common functions are pointing (moving the cursor or arrow on the screen by sliding the mouse on the mouse pad), clicking (using the left and right buttons) and scrolling (hold down the left button while moving the mouse).


### Mother Board
The main circuit board inside the computer—the big green panel that sits on the bottom of a Desktop PC or along the side of a tower. All the main parts of the PC plug into the motherboard to share data.

### Processor (CPU)
The chip that performs the majority of calculations and instructions needed to make your computer run. The processor is attached to the motherboard. It is often called the computer's "brain."

### Memory (RAM)
(Random Access Memory) Fast computer chips that temporarily store information while a PC is in use. These chips are the computer's short-term memory used to run applications. Most new PCs have at least 128 megabytes of memory.

### Hard Drive
The main storage area inside your computer (usually called a C: drive). The hard disk or hard drive stores your computer's operating system, the programs that are installed on your computer, and most of your files. Hard drive capacity is measured in gigabytes. Most new computers have at least 20 gigabytes of memory.
**Floppy Disk:** A 3.5" square holding a flexible magnetic disc that holds information or data. You need a floppy drive (usually called an **A: drive**) to read the floppy. A floppy disk can hold only 1.44 megabytes, but it is portable and allows you to make extra copies of your files.

**CD-ROM:** (Compact Disk Read-Only Memory) A removable disk which can store large amounts of information. Because it is Read-Only, new information cannot be saved to it. Requires a CD-ROM drive (usually called a **D: drive**) to read the information. A CD-ROM can hold 650 - 800 megabytes of information, much more than a floppy disk can hold. Some new computers have a **CD-RW** (Compact Disk ReWritable) drive which allows the user to save information onto a CD. This is done with lasers in a process called “burning”. Once the information is saved onto the CD, it can be read on any CD-ROM drive.

**Sound Card:** A device that can reproduce almost any sound, including music, speech, and sound effects. A computer must contain a Sound Card in order to produce sounds. You can attach speakers and/or a microphone to the sound card.

**Modem:** A device that translates data from your PC into a form that can be sent to other computers over regular phone lines. The modem also receives signals from other computers and converts it into something your computer can understand. A modem is the device most home computers use to connect to the Internet.
Putting It All Together

You (Computer Operator)

Operating System (GUI)

Programs (Software)

Word Processing
Spreadsheets
Web Browser
Desktop Publishing
Email
Drawing
Multimedia

Monitor
CPU
Printer
Scanner

Speakers

Keyboard

Mouse

Modem

Internet Connection
Bits, Bytes, Kilobytes, Megabytes & Gigabytes

**Bit:** We measure the information stored in a computer's memory and disk drives using bits. A bit is the smallest unit of measurement.

**Byte:** 8 bits grouped together equal one byte. A byte is still a very small piece of information--one byte is equal to one character or one letter of the alphabet. Since a byte can only hold a very small piece of information, we often think in terms of kilobytes, megabytes, and gigabytes.

**Kilobyte (KB):** Normally defined as 1,024 bytes, although many people round it to 1,000. An average word-processing document will consume about 100 kilobytes.

**Megabyte (MB):** Defined as roughly 1,000 kilobytes or 1,000,000 bytes. While documents are usually measures in kilobytes, whole programs are measured in megabytes. A few years ago, when you purchased a new program at the store, it most often came on a floppy disk. Each floppy disk holds up to 1.44 megabytes of information. Programs were smaller then, so you would only need a few disks to hold the whole thing. These days, the size of programs have become much bigger, so that virtually all new programs come on CD-ROM. A CD-ROM can hold over 650 megabytes!

**Gigabyte (GB):** Defined as roughly 1,000 megabytes. The increasing size of programs has resulted in larger hard drives. Hard drives used to be measured in megabytes -- a computer from 1988 might have had a 30-megabyte hard drive! Now, the average hard drive in a new computer is about 20 gigabytes.

<table>
<thead>
<tr>
<th></th>
<th>Smallest Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Bit</td>
<td>8 Bits</td>
</tr>
<tr>
<td>1 Byte</td>
<td>1,000 Bytes</td>
</tr>
<tr>
<td>1 Kilobyte (KB)</td>
<td>1,000 Kilobytes</td>
</tr>
<tr>
<td>1 Megabyte (MG)</td>
<td>1,000 Megabytes</td>
</tr>
<tr>
<td>1 Gigabyte (GB)</td>
<td>1,000 Megabytes</td>
</tr>
<tr>
<td>Storage Medium</td>
<td>Capacity Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Average Word Processing Document</td>
<td>A one page, single-spaced letter</td>
</tr>
<tr>
<td>Floppy Disk</td>
<td>1.44 MB (or 1440 KB)</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>650-800 MB (or 650,000–800,000 KB!)</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>Size varies, but a new hard disk is typically 20 GB (or 20,000 MB or 20,000,000 KB!).</td>
</tr>
</tbody>
</table>
Storage vs. Memory

**Storage** refers to where your computer keeps all the data/information that it uses (i.e. any programs that you might run, files that you have created, or the computer’s operating system). Your 3 main storage locations are:

1. The **Hard Drive** or **C:\ Drive**
2. The **Floppy Drive** or **A:\ Drive**
3. The **CD-ROM Drive** or **D:\ Drive**.

The computer's operating system and most frequently used programs (such as Microsoft Word) are stored on the **hard disk**. You might also store documents and other files you’ve created on the hard disk. **Floppy disks** are used to store files you’ve created so that you might work on them in multiple locations. They are also a good way to back up important information on your hard drive. **CD-ROMs** are used to store large programs. A CD-ROM can store over 650 MB of data, but remember that you can only save new information if it is a CD-R (because the **ROM** stands for “**Read Only Memory**”).

**Memory** chips are the fast computer chips used to temporarily store information while a PC is on. Hard disk space, however, is what the computer uses to store unused files and programs. When the computer is on and you are running programs, these programs are temporarily held in the computer's memory for easy access. When the computer is turned off, the hard disk still holds all your files and programs, but the memory is emptied.

Think of the difference between storage and memory as the difference between cabinets and drawers in your kitchen and your kitchen countertop. The storage areas in the computer are like cabinets and drawers in your kitchen. When you are not cooking, your pots, pans, bowls and ingredients are all stored away in cabinets and drawers. When you are preparing a meal, however, you take things out of their storage places and put them on the countertop to use them. The countertop here is like the computer's memory. When you are finished cooking, the ingredients, pots, pans, and bowls all go back to their storage areas because you no longer need them and your countertop is wiped completely clean.

Most computers today have at least 128 MB of memory, which means that your computer can handle up to 128 MB of information at a time.
What is an Operating System?

An operating system links you to your programs (also called applications or software) and then links your programs to the computer's hardware. It controls how the computer does its most basic tasks, like storing files or talking to printers.

Microsoft Windows XP is an example of an operating system. It uses graphics (pictures) to connect you to the computer's hardware and software in an easy-to-understand (hopefully!) way. Microsoft Windows XP also comes with many free, built-in programs that can help you create documents, movies and images, calculate figures, enjoy some music, browse the Internet, or play a few games.

Other examples of operating systems:

1. **Windows 2000/NT**: these recent versions of Windows are commonly used for computers that are networked together

2. **DOS, Windows 3.0, Windows 95, Windows 98 and Windows ME**: older

   **Mac OS**: operating system used by Apple Macintosh computers
Exploring the Desktop

Desktop: The opening screen in Windows XP. It contains Icons, the Start Button, the Taskbar, and the Notification Area.

1. Icons: Small pictures that represent the things you work with when you are using your computer. Icons can represent files, programs, folders, disk drives, Control Panel tools, shortcuts, or the Recycle Bin.

2. Start Button: The button found at the left end of the Taskbar that is labeled Start. Click here to open the Start Menu, where you can open other programs and menus.

3. Taskbar: The bar that appears at the bottom of the desktop. It shows you what programs or tasks are open. In the picture above, the Taskbar shows that the program Microsoft Word is open.

4. Notification Area: The area found at the right end of the Taskbar. It can give you quick access to changing your computer's volume, display properties, or mouse settings. It also displays the current time and date.
What is a Window? A Window is a rectangle on your screen that organizes how you view and work in specific programs or view files on your computer.

1. **Title Bar** - horizontal bar at the top of a window that holds the window's title or the name of the program you're using
2. **Menu Bar** - bar located under the title bar that lists available menus
3. **Status Bar** - bar at the bottom of a window that displays how many objects or icons are in the window
4. **Minimize Button** - shrinks your window to a button on your taskbar
5. **Maximize Button** - enlarges your window to completely cover your screen
6. **Close Button** - closes an open window
7. **Scroll Bar** – the rectangle at the side or bottom of the window that allows you to guide through the contents of a window (it will appear when there are many files to display)
To maximize a window:

1. Click on the window's **Maximize Button**.

2. Your Window will expand to its largest possible size.
To restore a window:

1. Click on the **Restore Button**. It looks like two Squares locked Together.

2. Your window will now return to its previous size – a medium size.

Notice how the **Scroll Bar** disappears. You do not need it because the window is big enough to show all of the objects.
To minimize a window:

1. Click on the **Minimize Button** in the top right hand corner of your window.

2. Your window will shrink to a button on the **Task Bar**. In this picture, I have two documents minimized: **My Documents** and **Using Windows TGH**...

3. To recall or activate a minimized window, click on its button on the **Task Bar**...
To resize a window:

1. Move your mouse pointer to the center of the Window and Click once. 8 Sizing Boxes appear. One in each corner, and one in the middle of each side of the window.

2. As soon as a double-headed arrow appears, hold your mouse button down and drag the window to the size you want it to be.

3. This is how little I could make the My Documents window when I resized it!
Exploring the Start Menu

You can find the **Start Button** in the corner of your screen. Just like the name suggests, this is an excellent place to *start* your work. When you click on the **Start Button**, a special list called the **Start Menu** appears.
Start Menu Options:

1. **All Programs** - Point your mouse here to see what programs (or applications) are installed on your computer.
2. **Programs** - See a list of the last 8 programs you used. This is a quick way to get back to a file you have been working on.
3. **My Documents** – Point your mouse here to see this folder that holds files saved here.
4. **My Pictures** - Point your mouse here to see pictures saved in this location.
5. **My Music** - Point your mouse here to see music files stored here.
6. **My Computer** - Point your mouse here to see Shared Folders, Hard Disk Drives and CD – Removable Devices
7. **My Network Places** – Allows you to program your computer on a network
8. **Control Panel** - Allows access to Appearance and Themes, Network and Internet Settings, Sound, Speech and Audio Devices, Performance and Maintenance, Add or Remove Programs, Users Accounts, Printer and Other Hardware Settings, Date and Time Settings, and Accessibility.
9. **Connect To** – Pint here if you want to connect to your ISP (Prodigy)
10. **Search** - Point here if you want Windows to search for a particular file on any of the computer's storage drives.
11. **Help and Support** - Click here to bring up the Windows XP Help Menu. A great place to go if you need tips on using Windows XP.
12. **Run** - Can be used to run (or start up) programs, but is usually used to install new software on a computer.
13. **Log Off** – If you use a password to sign onto Windows, this option allows you to end your Windows session.
14. **Turn Off Computer** - Click here when you are ready to shut down Windows for the day or when you need to restart the computer.

Getting around the Start Menu:

To move through the Start Menu, point your mouse to one of the menu options.

![All Programs](image)

When this little green arrow appears at the end of a menu option, pointing to that option will open a new menu.
For example, after you point to the **All Programs** line in the **Start Menu**, a new menu pops up listing all the names of all the programs (or folders full of programs) installed on your computer. If you see the name of the program you want, click on the name to start the program.

To create a shortcut for a program on the desktop:

1. On the Start menu, click **All Programs**.

2. Right click on the application from the list (for example, Microsoft Word or Internet Explorer) and select **Send To > Desktop**. A shortcut will appear on the desktop.
Accessories are free programs that come with Windows XP. They are good to know about because you can find them on any computer running Windows and they can do some pretty handy things.

To get to Accessories:

1. Click on the Start Button
2. Move the mouse pointer to the All Programs
3. Move the mouse pointer to the Accessories
1. **Accessibility** – These programs will adjust Windows XP for special hearing, vision and mobility needs. For example, the Magnifier works like a magnifying glass to enlarge portions of your screen to make them easier to read.

2. **Communications** - These programs are used to connect to the Internet, connect one computer to another, or to actually dial your telephone for you. Most likely, you will not need to use any of these (most Internet service companies provide software that set up your Internet connection).

3. **Entertainment** - If your computer has Windows XP, a sound card, speakers, and a CD-ROM drive, you can play audio CDs through the Real Player program. You can also record and edit sounds here, adjust the computer's volume and play multimedia files. I like the CD Player option best!

4. **System Tools** - These built-in programs are here to help you maintain your computer. You should not try to use them unless you are certain about their function. The two I use regularly are Disk Cleanup and Disk Defragmenter. We’ll learn more about them in a future lesson.
5. **Calculator** - This program works just like a regular calculator. You can enter numbers and operators either with your keyboard or with your mouse. Note--to divide, use the / key and to multiply use the * key.

6. **Notepad** - This is a quick little word processing program. You can type in text, save what you have written, and print out what you have typed. That's about the extent of what it can do--it's a fairly limited word processing program.

7. **Paint** - An excellent drawing program. You can use it to practice your mouse skills and create your own artwork.

8. **WordPad** – The other word-processing Program that comes with Windows XP. This is one more complex than Notepad – you can change text formatting, save documents and print out what you have typed. This program is less complicated than many fuller programs (like Microsoft Word), so it's a great place to start if you are new to computers. It's an easy-to-use program for writing letters, reports, or term papers. It’s major shortcoming: it has no spell checker!

Of all these accessories, the ones I use most often are the Calculator, Real Player, Paint, Disk Cleanup, Disk Defragmenter.
Using the Control Panel

The Control Panel is a special folder in Windows XP that contains all the special configuration options for your computer. It allows you to personalize your computer to fit your needs.

To open the Control Panel:

1. Click on the Start Menu
2. Move the mouse pointer to Control Panel

The Control Panel window will now open on your screen:
What do all these icons do?

<table>
<thead>
<tr>
<th>Appearance and Themes</th>
<th>Special &quot;looks&quot; that you can choose for your computer--the underwater theme adds fish to your desktop and makes your computer sound like an aquarium. You can change the computer's background, color scheme, resolution, and screen saver with this useful option. You can also add new fonts (a font is text style) to your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network and Internet Connections</td>
<td>Allows you to adjust Modem settings. Helps you with instant messaging options, setting up a home network, and provides a firewall to protect your privacy.</td>
</tr>
<tr>
<td>Add or Remove Programs</td>
<td>Helps you install new software and uninstall programs you don't want anymore.</td>
</tr>
<tr>
<td>Sounds, Speech and Audio Devices</td>
<td>Changes what sounds your computer makes when different events occur. You can record your own sounds, as well as set up and adjust the sound from CDs, MP3s or games that use sound.</td>
</tr>
<tr>
<td>Performance and Maintenance</td>
<td>Tools and programs that can help keep your computer safe, handle routine maintenance tasks and restore your system, if needed. You can also control power options to save energy.</td>
</tr>
<tr>
<td>Printers and Other Hardware</td>
<td>Helps you install a printer, perform basic printer tasks and fix printer problems. You can add or change settings for your mouse, keyboard, game controllers, phone, modem, fax and scanners. For example, you can adjust your mouse to be more sensitive to your clicking rate or to be oriented for a left-hander.</td>
</tr>
<tr>
<td>User Accounts</td>
<td>Helps you set up accounts with pictures and passwords for everyone who uses your computer. This way you can have different personal settings for different users at one computer.</td>
</tr>
<tr>
<td>Date, Time, Language and Regional Options</td>
<td>In this area you can make changes to your computer's time, date, and time zone. You can also adjust your keyboard here for different language settings, and you can change how numbers, currencies and dates are displayed.</td>
</tr>
<tr>
<td>Accessibility Options</td>
<td>Allows you to adjust the text and color combinations for your screen and adjusts the computer settings to make it easier for people to use with special physical needs.</td>
</tr>
</tbody>
</table>

Options with the bell symbol 📣 next to them are either used very infrequently or should be used very carefully, as they could affect the smooth functioning of your computer system.
Changing the Display Options

There are 2 ways to access the Display Properties to change how your Desktop looks.

Option 1:
1. Open the Control Panel
   (Reminder: To get to the Control Panel, click on Start, and then click on Control Panel)
2. Click on Appearance and Themes
3. Select the Display icon.
4. The Display Properties dialog box will now appear on your desktop.

Option 2:
1. Right-click the mouse pointer somewhere in the "empty" space on your desktop
2. A pop-up menu will appear. Click on the option Properties.
To change the Background on your Desktop:

There is a collection of special graphics in Windows XP that can be spread across the background of your computer screen.

1. Click on the Desktop tab.
2. Scroll through the list to find a Background option that you like. When you select an option, a preview appears in the mini-monitor.
3. Click here to Tile (repeat), Stretch, or Center the wallpaper across your desktop.
4. After you find the option you want, click on Apply.

If you just want a solid color as your desktop background, select the None option at the top of the background menu.
To change the Screen Saver in Windows 98

In the past, leaving a computer on for long periods of time risked permanently damaging the monitor because the images displayed on the monitor could burn themselves onto the monitor's screen. Screen Savers were invented to protect monitors from this problem. Whenever a computer hasn't been used for a while, the screen saver either turns the screen all black or fills the screen with moving images. Today, monitors don't have this problem, but people like to use screen savers as a way to express themselves and because they are fun.

1. Click on the **Screen Saver** tab.

2. Click on the drop-down list to see the screen saver choices.

3. When you select a screen saver option, a preview will appear in the mini-monitor.

4. Click on the **Preview** button to see what will happen to the entire screen when the screen saver starts up.

5. Click here to choose how long you want the computer to be idle before the screen saver starts.

6. Click **Apply** to save the new settings.

**HINT:** To stop a screen saver, just shake the mouse.
To make other changes to your screen's appearance:

You can change the background color of your desktop and many other window items through the Appearance tab.

1. Click on the Appearance tab.

2. Click here to set the Windows XP or Windows Classic window and button style.

3. Click here to select a color scheme for your computer - schemes are built-in color designs that affect your desktop color, windows and icons.

4. Click here to change the font size from normal to large or extra large.

5. A preview appears in the mini-desktop area to show what the new scheme will look like.

6. Click **Apply** to save the changes.
To change the resolution in Windows XP:

Your monitor and video card can display different numbers of color on-screen and can display different resolutions. The higher the resolution, the more information you can pack onto your screen at once and the smaller everything will appear on screen. Different programs (especially children’s software) require different color modes and resolutions, so it’s important to know how to change these.

1. Click on the Settings tab.

2. Click here to select how many colors you want to display on-screen. The two choices are Medium Color (16 bit) or Highest Color (32 bit). Keep in mind: with more colors displayed, your screen will look better, but it uses more memory.

3. Slide the bar to change your resolution or screen area. Sliding the bar to the right increases the resolution and shrinks the appearance of everything on your screen.

4. Click on Apply to save your changes. The screen will go blank while it is being reconfigured. This box appears to see if you want to accept the changes. It will automatically change back to the previous setting if you do not press yes.
Using My Computer

**My Computer** is a quick and easy way to get access to the folders and files stored in your computer system. It allows you to choose a particular storage location or drive and view the folders and/or files stored in that drive.

**To open My Computer:**

1. Click on **Start**

2. Double-click on the **My Computer** icon.

2. The **My Computer** window opens. Double-click on an object's icon to see the contents of that object.
To view the contents of a storage drive:

To see what is stored on one of the computer's drives, double-click on the icon representing that drive. A new window will open displaying all the folders and files stored on the selected drive.

For example, to view the contents of your machine's hard drive:

1. Double-click on the icon for the hard drive (or C: drive).

2. A new window opens displaying the contents of your hard drive. Each folder contains more folders and files.

3. A Pop-Up window lists how many objects are in the open window.
The objects in the **My Computer** window can be viewed five different ways:

1. ** Thumbnails**: objects are displayed in boxes
2. **Tiles**: objects are displayed with large icons
3. **Icons**: objects are displayed with small icons in order from left to right
4. **List**: objects are displayed in a list in order from top to bottom
5. **Details**: objects are displayed with details about each item

**Step 1:** To change how the objects in the window are displayed, click on the **View** menu.

**Step 2:** Select the option you want from the menu that appears. The **Tiles** option is the current option--a circle identifies the current option.

---

**Thumbnail View**

**Details View**

**Icons View**

**List View**
To view the amount of space available on a drive:

1. Place the mouse over the icon. A window pops up showing the total space and the space used.

2. Right-click on the icon for the drive. To see the available storage space on your hard drive, right-click on the C: drive. A pop-up menu appears. Select **Properties** from the menu.

3. A new window opens showing the amount of used disk space and available or free disk space.

   This hard drive has:
   
   **10.8 Gigabytes** of used space
   **22.0 Gigabytes** of free space
   **32.9 Gigabytes** total capacity
Creating Folders

*Windows XP uses Folders to organize how information or data is stored on disks (hard disks, floppy disks, CD-ROMs, or DVD-ROMs). Folders can hold files, other folders, and/or objects (such as printers).*

Folders are easy to create and are a great way to organize files that you create on your computer.

**To create a new folder:**

1. Right-click in the window.
2. Move your mouse pointer to **New** in the menu that appears.
3. Select **Folder** in the second menu that appears.
4. A new folder will appear in the window where you initially clicked. The default title for your new folder will be **New Folder**.

You should rename it to something more meaningful by clicking in the space under the folder icon where the text appears. As soon as you see the cursor blinking in the line, you may begin to type in a new name for the folder. You can rename a folder by right-clicking the mouse on the folder icon and choosing **Rename**.
Other ways to create new folders:

1. Click on the **File** menu located in either a disk drive window’s menu bar or another folder’s menu bar.
2. Again, point to **New** in the menu that opens.
3. Select **Folder** from the pop-up menu.
4. A new folder will appear within the space of the open window and you may rename it as described above.

Windows XP also features **File and Folder Task** boxes that make it easy to manage your files and folders.
Deleting Files and Folders

There are several quick and easy ways to delete files or folders from a hard drive or a floppy disk.

To delete a file from the hard drive:

1. Go to My Computer. (Remember to click on Start. Double click on My Computer.)

2. Double-click on My Documents

3. Double-click the folder containing the desired file.
5. Highlight the file name.

6. There are 4 ways to delete files.
   - Press the **Delete** key on your keyboard.
   - Right-click the file and select **Delete**.
   - Select **Delete this File** from the **File and Folder Tasks** Menu.
   - Click on the **File** menu bar and select **Delete** from the menu.

6. The following message will appear on your screen. Click on **Yes**. Your file will be deleted and sent to the Recycle Bin.
If you delete a file by mistake, you can “restore” it by:

- Dragging it out of the Recycle Bin,
- Right-clicking the file name and selecting Restore
- Or selecting Restore this Folder from the File and Folder Tasks menu.

To delete a folder from the hard drive:

1. Go to My Computer. (Remember to click on Start. Double click on My Computer.)

2. Double-click on the icon for the hard drive (or C: drive).
3. A new window will open displaying the contents of your hard drive.

4. Find the folder that you want to delete. Click once to select it.

6. The following message will appear on your screen. Click on **Yes**. Your folder will be deleted and sent to the **Recycle Bin**.

When you delete a folder from your hard drive, the folder and all of the files in it go into the Recycle Bin. You can “restore” it by dragging it out of the Recycle Bin or selecting **Restore this Folder** from the **File and Folder Tasks** menu.

**NOTE:**
To empty the Recycle Bin:

1. Double-click on the **Recycle Bin** icon on the desktop.

2. The **Recycle Bin** window opens.

3. You can choose 1 of 3 options:
   - Click on **File** in the **Menu** bar and select **Empty Recycle Bin**
   - Click on **Empty Recycle Bin** in the **Recycle Bin Tasks** menu.
   - Right-click in the window and scroll down to **Empty Recycle Bin**

4. A box appears. Click on **Yes** to delete all the files in the **Recycle Bin**.
To delete items from a floppy disk:

1. Go to **My Computer**.  
   (Remember to click on **Start**.  Double click on **My Computer**.)

2. Double-click on the **Floppy Disk** icon.

3. Highlight the file name.

4. Remember the 4 ways to delete your file:
   - Press the **Delete** key on your keyboard.
   - Right-click the file and select **Delete**.
   - Select **Delete this File** from the **File and Folder Tasks** Menu.
   - Click on the **File** menu bar and select **Delete** from the menu.
6. The following message will appear on your screen. Click on Yes. Your file will be deleted.

**NOTE:**

When you delete a file from your floppy disk, it does **not** go into the Recycle Bin. It is deleted!
Shutting Down the Computer

In order to turn off your computer safely, you must follow these steps:

1. Click on the **Start Button** on the Task Bar.

2. Click on the **Turn Off Computer** in the Start Menu

3. The following box will appear on your screen. Make sure the option **Turn Off** is selected.

Your computer will do one of two things:

1. it will either power itself off so that you **do not** need to turn off the power button.

**OR**

2. it will give you a message **“It is now safe to turn off computer.”** When you see this message, you can turn off your computer.